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Connexion à un routeur réseau
Connectez le lecteur au routeur réseau via une des méthodes illustrées sur 
cette page.

❙❙ Réseau câblé

✎✎ Remarques
●● Il est possible que l'accès Internet au serveur de mise à jour Samsung ne soit pas 
autorisé, selon le routeur que vous utilisez ou le contrat établi avec votre fournisseur 
d'accès. Pour de plus amples informations, contactez votre fournisseur d'accès 
Internet.

●● Les utilisateurs DSL doivent passer par un routeur pour la connexion au réseau.
●● Pour utiliser la fonction AllShare, vous devez connecter l’ordinateur au réseau, tel 
qu’indiqué dans les illustrations à gauche. La connexion peut être câblée ou sans fil.

Service large 
bande

Modem large bande  
(avec routeur intégré)

Modem large bande 

Routeur

Ou

Service large 
bande

❙❙ Réseau sans fil

✎✎ Remarques
●● Pour plus d'informations, veuillez vous reporter au manuel d'utilisation du lecteur.

+

Service large bande

Routeur sans fil Si le modèle du lecteur utilisé ne dispose 
pas de fonction Wi-Fi intégrée, vous 

devrez recourir à un adaptateur LAN sans 
fil de Samsung.
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Configuration de la connexion réseau : 
Étapes initiales

1	 Appuyez sur le bouton [HOME] de 
la télécommande.

※※ Si vous disposez d'un réseau sans fil, assurez-
vous que le point d'accès auquel vous 
souhaitez relier votre lecteur est activé. Le 
point d'accès peut être un routeur sans fil, un 
modem, etc. Si vous utilisez un réseau cablé, 
reliez l'extrémité d'un câble LAN au port LAN situé à l'arrière du lecteur et l'autre extrémité au 
routeur ou au modem.

2	 Depuis l'écran 
Accueil, accédez à 
<Paramètres>, puis 
appuyez sur le bouton 
s.

3	 Sélectionnez 
<Réseau>, puis 
appuyez sur le bouton 
s.

HOME SMART

HUB

4	 Allez sur <Paramètres 
réseau>, puis 
appuyez sur le bouton 
s.

5	 Lorsque la fenêtre 
Paramètres réseau 
s'affiche, reportez-
vous à la section 
« Réseaux câblés », en 
page 5 ou « Réseaux 
sans fil », en page 
6, pour terminer la 
configuration du 
réseau.

※※ Le lecteur prend en charge diverses méthodes de configuration réseau (Câblé/Sans fil, WPS 
(PBC)) qui vous permettent de configurer le réseau aisément et rapidement.
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❙❙ Réseaux câblés

Câblé - Automatique

Optez pour la procédure automatique si le réseau ne requiert pas 
d'adresse IP fixe. La plupart des réseaux n'exigent pas d'adresse IP fixe.

1	 Sélectionnez Câble 
dans le menu 
Paramètres réseau, 
puis appuyez sur le 
bouton s. 

2	 Le lecteur vérifie la 
connexion réseau 
puis se connecte au 
réseau.  
Appuyez sur le 
bouton s lorsque 
le processus de la 
connexion réseau est 
terminé.

Câblé - Configuration manuelle

Si vous disposez d'une adresse IP fixe ou si la procédure automatique 
est inopérante, vous devrez définir les valeurs de Paramètres réseau 
manuellement. 

1	 Sélectionnez <Câble> depuis l'écran Paramètres réseau, puis 
appuyez sur le bouton s. L'écran État du réseau apparaît. Le 
lecteur tente de vérifier la connexion réseau et échoue. 

2	 Sélectionnez <Param. 
IP>, à la droite de 
l'écran, puis appuyez 
sur le bouton s. 
L'écran Paramètres IP 
apparaît.

3	 Sélectionnez le champ Mode IP, puis réglez-le sur Manuel.
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4	 Utilisez les boutons numériques de la télécommande pour entrer les 
valeurs de paramètres réseau. Servez-vous des boutons ▲▼◄► 
de la télécommande pour passer d'un champ de saisie à l'autre.

✎✎ Vous pouvez obtenir ces valeurs auprès de votre fournisseur Internet. Vous 
pouvez aussi afficher ces valeurs sur la plupart des ordinateurs Windows.

5	 Une fois que vous 
avez terminé, 
sélectionnez OK, puis 
appuyez sur le bouton 
s. Le lecteur vérifie 
la connexion réseau 
puis se connecte au 
réseau. 

❙❙ Réseaux sans fil

1	 Assurez-vous que le point d'accès auquel vous souhaitez connecter 
votre lecteur est activé. Le point d'accès peut être un routeur sans fil, 
un modem, etc.

2	 Sélectionnez Sans 
fil (généraux) dans 
le menu Paramètres 
réseau, puis appuyez 
sur le bouton s.

3	 Appuyez sur le 
bouton s. Le lecteur 
lance le balayage des 
points d'accès. À 
la fin de l'opération, 
il affiche une liste 
des points d'accès 
détectés.
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4	 Passez au point 
d'accès auquel vous 
souhaitez connecter le 
lecteur, puis appuyez 
sur le bouton s. 

5	 Appuyez sur le 
bouton s. Le lecteur 
se connecte au 
réseau.

✎✎ Si votre réseau 
dispose d'une clé de 
sécurité, la fenêtre de 
saisie correspondante 
apparaîtra. Entrez la clé 
via le clavier. Une fois 
l'opération terminée, 
servez-vous des 
boutons ▲▼◄►pour 
sélectionner Fait, 
appuyez sur le bouton 
s, puis passez à 
l'étape 6.

5-1	Si vous souhaitez 
utiliser une adresse IP 
fixe, sélectionnez 
<Param. IP> à 
l'écran, puis entrez 
manuellement les 
paramètres de 
l'adresse IP requis.
-- Adresse IP
-- Masque s.-réseau
-- Passerelle
-- Serveur DNS

6	 Une fois que vous 
avez effectué la 
configuration des 
paramètres réseau, 
appuyez sur le bouton 
<OK>.

✔✔ Utilisation d'un appareil prenant en charge le protocole WPS 
1.	 Exécutez les étapes 1 à 5 de la section « Configuration de la connexion réseau : Étapes 

initiales ».
2.	 Sélectionnez « WPS(PBC) ».
3.	 Suivez les instructions qui s'affichent à l'écran.

✎✎ Remarques
-- Les appareils prenant en charge le protocole WPS disposent d'un bouton WPS 

(PBC).  
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Installation et utilisation de l'application 
AllShare sur votre ordinateur

❙❙ Téléchargement de l'application AllShare

Pour utiliser AllShare sur votre ordinateur ou un périphérique DLNA, 
vous devez préalablement installer l'application AllShare sur l'ordinateur 
concerné.  
Vous pouvez télécharger le logiciel AllShare et obtenir des instructions 
détaillées sur l'utilisation de la fonction AllShare depuis le site Web 
Samsung.com. 

1	 Allez sur www.samsung.com. 

2	 Cliquez sur Assistance dans le haut de la page. 

3	 Sur la page Assistance, saisissez le numéro de modèle de votre 
lecteur dans le champ Numéro de modèle, puis appuyez sur le 
bouton Rechercher le produit.

4	 Sur la page qui apparaît, cliquez sur la commande Télécharger, 
située à gauche, sous Téléchargements. La page Centre de 
téléchargement apparaît. 

5	 Sur la page Centre de téléchargement, cliquez sur l'onglet Logiciels. 

6	 Depuis l'onglet Logiciels, cliquez sur l'icône Fichier, à droite de la ligne 
AllShare.

7	 Dans la fenêtre contextuelle qui apparaît, cliquez sur Sauvegarder le 
fichier. 

8	 Recherchez le fichier d'installation AllShare sur votre disque, puis 
cliquez deux fois sur le fichier. 

9	 Dans la fenêtre contextuelle qui apparaît, cliquez sur Exécuter, puis 
suivez les directives qui s'affichent à l'écran.
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❙❙ Installation du logiciel AllShare

Pour installer le logiciel AllShare, exécutez les étapes suivantes.

1	 Après avoir téléchargé le logiciel AllShare, lancez le programme 
d'installation.

2	 Sélectionnez la langue 
de votre choix, puis 
cliquez sur « OK ».

3	 Accédez à 
l'emplacement 
d'installation du 
logiciel pour lire le 
contrat de license. 
Si vous adhérez 
aux conditions 
d'utilisation du logiciel, 
sélectionnez « I accept 
the terms of the 
license agreement », 
puis cliquez sur 
« Next ».

4	 Les fichiers requis 
pour l'exécution du 
logiciel sont alors 
installés.

5	 Une fois l'installation 
terminée et les 
raccourcis créés, 
sélectionnez si vous 
souhaitez ou non lancer 
le logiciel, puis cliquez 
sur « Finish » pour 
finaliser l'installation.
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❙❙ Disposition des écrans AllShare

Le logiciel AllShare comporte trois écrans.
Écran Gestion de fichiers

Pour accéder à l'écran 
Gestion de fichiers, 
sélectionnez View >
File management
screen mode dans le menu 
supérieur ou cliquez sur le 
bouton File management 
screen mode.

A.	 Zone de navigation
●● Connected shared device : Affiche le contenu partagé sur les périphériques 

connectés à votre ordinateur (identifié à l'écran comme étant Poste de travail).
●● Content list : Affiche le contenu par catégorie de vidéo/photo/musique.
●● Transfer/Back up list : Affiche l'état de progression ou d'achèvement des 

opérations de transfert et de sauvegarde.
●● Playlist : Crée et exécute une liste d'écoute personnalisée de morceaux, de 

photos ou de vidéos.

B.	 Zone de la liste de contenus
●● Affiche le contenu de la liste que vous sélectionnez dans la zone de navigation.

C.	 �Boutons Lecture sur un autre périphérique / Transfert vers un 
autre périphérique / Sauvegarde sur le Poste de travail

●● Play on another device : Appelle l'écran de sélection du périphérique sur lequel 
vous souhaitez lire le contenu choisi.

●● Transfer to another device : Appelle l'écran de sélection du périphérique vers 
lequel vous souhaitez transférer le contenu choisi.

●● Save to My Computer : Appelle l'écran de sélection du dossier sur lequel vous 
souhaitez enregistrer le contenu choisi.

D.	 Fonctions supplémentaires
●● Refresh : Actualise la liste toute entière.
●● List view/Thumbnail view : Permet, lorsqu'on clique dessus, de changer la 

méthode d'affichage de liste.
●● Recherche : Recherche le contenu souhaité dans la zone des listes de contenus.

E.	 Player control screen mode
●● Bascule en mode Écran de commande du lecteur.
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2	 Paramètres des privilèges du Poste de travail, configurez les 
privilèges de partage que chaque périphérique connecté a en 
commun avec le dossier partagé du Poste de travail.

●● Si vous sélectionnez Toujours autoriser, les périphériques pourront 
utiliser le contenu partagé sur le Poste de travail à la première 
requête d'accès, sans générer de fenêtre de notification contextuelle. 

●● Allow all/Forbid all : Autorise/interdit les privilèges d'accès à tous 
les périphériques actuellement connectés.

●● Vous pouvez définir les privilèges d'accès des différents 
périphériques en sélectionnant la commande autoriser/bloquer, 
située à côté de chaque périphérique dans la liste.

●● Pour retirer un périphérique de la liste, cliquez sur le bouton  
situé à côté du périphérique concerné.

3	 Dans Autoriser la lecture distante sur le Poste de travail, définissez 
les règles de lecture distante pour les périphériques qui accèdent au 
Poste de travail.

●● « Always show pop-up when playback is requested » : Lorsque 
cette option est sélectionnée, AllShare affiche les requêtes de 
lecture émises par d'autres périphériques au Poste de travail 
sous forme d'une fenêtre contextuelle. 

●● Always allow : Lorqu'un autre périphérique envoie une demande 
de lecture au Poste de travail, la lecture est accordée sans fenêtre 
de notification contextuelle.

●● Never allow : Les périphériques ne peuvent pas être lus sur le 
Poste de travail.

Connexion au lecteur et à d'autres 
périphériques compatibles DLNA 

Avant de pouvoir connecter votre ordinateur à un périphérique, vous devez 
d'abord le relier à votre réseau domestique.

✎✎ Remarques
-- Si vous n'arrivez pas à effectuer la connexion à votre réseau domestique, veuillez 

contacter votre administrateur réseau ou votre fournisseur de routeur ou de services 
Internet. 

-- Si vous rencontrez des difficultés de connexion à un périphérique DLNA (comme 
par exemple, un téléphone mobile), veuillez consulter le manuel d'utilisation du 
périphérique concerné.

❙❙ �Autorisation d'accès accordée à un périphérique 
connecté

1	 Accédez à l'onglet 
Tools > Settings > 
Privilege settings.
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Ajout de dossiers partagés
Vous pouvez ajouter un dossier partagé en effectuant l'une des actions 
suivantes :

●● Dans l'écran Gestion de fichiers, cliquez sur le bouton Dossier partagé , en haut de 
Liste d'appareils à gauche, sélectionnez le dossier que vous souhaitez partager dans 
la liste qui apparaît, puis cliquez sur OK.

●● Cliquez sur File > Add shared folder from My Computer, sélectionnez le dossier 
que vous souhaitez partager dans la liste qui apparaît, puis cliquez sur OK.

●● Cliquez sur Tools > Settings > Folder Settings > Add Shared Folder. Sélectionnez 
un dossier dans la liste qui apparaît, puis cliquez sur OK dans la liste, et cliquez 
ensuite à nouveau sur l'onglet Paramètres des dossiers.

Ajout de fichier au dossier partagé dans Poste de travail

Vous pouvez ajouter un fichier à un dossier partagé en effectuant l'une des 
actions suivantes :

●● Depuis l'écran Gestion de fichiers, cliquez sur Add files to play to the list dans 
My Computer's Shared Folder, à droite. Dans la fenêtre du fichier qui apparaît, 
sélectionnez les fichiers que vous souhaiter partager, puis cliquez sur Open. Une 
nouvelle fenêtre s'affiche dans laquelle vous pouvez cliquer sur Copier, Déplacerou 
Annuler. Si vous cliquez sur Copier ou Déplacer, les fichiers apparaîtront dans l'écran 
Gestion de fichiers.

●● Accédez à File > Add File to My Computer's Shared Folder. Dans la fenêtre 
du fichier qui apparaît, sélectionnez les fichiers que vous souhaiter partager, puis 
cliquez sur Open. Une nouvelle fenêtre s'affiche dans laquelle vous pouvez cliquer 
sur Copier, Déplacer ou Annuler. Si vous cliquez sur Copier ou Déplacer, les fichiers 
apparaîtront dans l'écran Gestion de fichiers.

Ajout effectué depuis l'explorateur Windows

Depuis l'explorateur Windows, sélectionnez le dossier/fichier que vous 
souhaitez partager et faites-le glisser dans le dossier partagé du Poste de 
travail ou dans la zone des listes de contenus de l'écran Gestion de fichiers 
afin de l'ajouter au dossier/fichier partagé.

Création d'une liste d'écoute dans AllShare
●● Ajout d'une liste d'écoute : 
Cliquez sur Add new 
playlist, à côté de Liste 
d'écoute, puis entrez le nom 
que vous souhaitez attribuer 
à la liste d'écoute.

●● Play on another device : 
Cliquez avec le bouton droit 
sur la liste d'écoute que 
vous souhaitez lire, puis 
faites passer le curseur de la souris sur Play on another device afin de sélectionner 
le périphérique sur lequel vous souhaitez lire la liste d'écoute.

●● Attribution d'un nouveau 
nom à une liste d'écoute : 
Cliquez avec le bouton 
droit de la souris sur la liste 
d'écoute que vous souhaitez renommer, puis cliquez sur Rename afin d'attribuer un 
nouveau nom à la liste d'écoute sélectionnée. 

●● Suppression d'une liste d'écoute : Cliquez avec le bouton droit de la souris sur la liste 
d'écoute que vous souhaitez supprimer, puis cliquez sur Delete afin de supprimer la 
liste d'écoute sélectionnée. 

●● Ajout de contenu à une liste d'écoute : Pour ajouter du contenu à une liste d'écoute, 
sélectionnez la liste comportant le contenu que vous souhaitez ajouter sous Device 
List/Content List dans la zone de navigation, puis sélectionnez le contenu de 
votre choix dans la zone Liste de contenus et faites glisser le contenu dans la liste 
d'écoute.

●● Suppression de contenu d'une liste d'écoute : Sélectionnez la liste d'écoute 
comportant le contenu que vous souhaitez supprimer, sélectionnez le contenu à 
retirer dans la zone Liste de contenus. Vous pouvez ensuite choisir de cliquer avec 
le bouton droit sur le contenu puis de cliquer sur Delete ou d'appuyer sur la touche 
Suppr pour supprimer le contenu. 
(La suppression d'un contenu d'une liste d'écoute ne le supprime pas pour autant ni 
de la Liste de périphériques ni de la Liste de contenus.)
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Sélection d'un périphérique depuis l'écran 
AllShare du lecteur

1	 Connectez les périphériques souhaités au réseau câblé/sans fil.

2	 Sélectionnez Mes appareils sur l'écran ACCUEIL du lecteur de disque 
Blu-ray.

3	 Sélectionnez d'abord 
l'appareil, puis les 
contenus que vous 
souhaitez lire (vidéos, 
photos ou musique).

✎✎ Remarques
-- Même en l'absence d'installation de l'application AllShare, les périphériques DLNA 

peuvent être connectés et apparaître sur l'écran Mes appareils de votre lecteur. (Ils 
doivent toutefois avoir été préalablement reliés au réseau.)

-- Les périphériques non compatibles avec les appareils Samsung ne peuvent pas être 
connectés.

❙❙ �Lecture de fichiers vidéo depuis l'ordinateur sur le 
lecteur

Vous préférez regarder un film en famille, sur le téléviseur, à partir du lecteur, 
plutôt que de le visionner tout seul sur votre ordinateur ? 
Essayez d'utiliser AllShare pour transférer le contenu concerné vers le lecteur. 
Vous pouvez également ajouter du contenu ou un dossier partagé 
comportant le contenu que vous souhaitez lire.

1	 Allumez le lecteur.

2	 Exécutez le logiciel AllShare installé sur l'ordinateur.

Ordinateur

Connexion AllShare

Lecteur de disque Blu-ray

Lecture du fichier de 
l'ordinateur
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3	 Si le dossier 
comportant la vidéo 
que vous souhaitez 
lire n'est pas partagé, 
cliquez sur le bouton 
en regard de l'élément 
« My computer’s 
shared folder » afin 
d'ajouter le dossier 
partagé.

✎✎ La liste pourra nécessiter un certain temps pour être recréée si elle comporte 
un grand nombre de fichiers.

4	 Sous Liste de 
contenus, sélectionnez 
la vidéo que vous 
souhaitez lire.

5	 Cliquez sur le bouton 
« Play on another 
device ».

6	 Sélectionnez le 
périphérique sur ou 
via lequel ou vous 
souhaitez lire le 
contenu (le lecteur 
Blu-ray).

7	 Une fois la vidéo mise 
en mémoire tampon, 
elle s'exécute via le 
lecteur et s'affiche sur 
l'écran du téléviseur. 

✎✎ Assurez-vous de régler 
le téléviseur sur la 
source à laquelle vous 
avez connecté le lecteur 
Blu-ray.
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QUESTIONS-RÉPONSES
Je viens d'installer AllShare sur mon ordinateur, mais je n'arrive pas à 
détecter l'ordinateur sur l'application AllShare du lecteur.

●● Vérifiez que le lecteur et l'ordinateur sont correctement branchés et leurs connexions 
sécurisées. 

●● Assurez-vous que toutes les connexions de câble réseau (routeur vers ordinateur, 
routeur vers model, etc.) sont correctement branchées et sécurisées.

●● Vérifiez que le lecteur est connecté au réseau et que sa configuration réseau est 
correctement établie.

●● Assurez-vous que des adresses IP appropriées ont été attribuées au lecteur et à 
l'ordinateur. 

●● Vérifiez que le lecteur et l'ordinateur sont connectés au même segment de réseau. 
Comparez les trois premiers ensembles de chiffres dans les adresses IP des deux 
appareils. Ils doivent être identiques.

●● Veillez à régler le lecteur sur Autorisé dans l'onglet Paramètres des privilèges AllShare 
(Tools > Settings > Privilege settings).

●● Certaines applications pare-feu qui s'exécutent sur l'ordinateur telles que McAfee 
ou Norton AntiVirus peuvent bloquer les opérations liées à AllShare ainsi que l'accès 
du lecteur à l'ordinateur. Arrêtez l'exécution de tels programmes ou réglez-les de 
manière à ce qu'ils autorisent les applications AllShare à accéder à l'ordinateur.

Je n'arrive pas à trouver l'adresse IP du lecteur de disque Blu-ray dans le 
menu des réglages des droits d’accès du logiciel AllShare sur l'ordinateur.

●● Vérifiez que le lecteur est connecté au réseau et que sa configuration réseau est 
correctement établie.

●● Assurez-vous que des adresses IP appropriées ont été attribuées au lecteur et à 
l'ordinateur. 

●● Vérifiez que le lecteur et l'ordinateur sont connectés au même segment de réseau. 
Comparez les trois premiers ensembles de chiffres dans les adresses IP des deux 
appareils. Ils doivent être identiques.

●● Vérifiez que le lecteur et l'ordinateur sont connectés au même routeur.
●● Le lecteur peut ne pas être reconnu sur un certain nombre de modèles ou de 
configurations de routeur. Vérifiez si le routeur utilisé prend en charge la multidiffusion. 
Le cas échéant, vérifiez la configuration de multidiffusion du routeur.

Je n'arrive pas à retrouver les contenus multimédia, même si le fichier est 
défini pour être partagé sur l'ordinateur.

●● AllShare ne prend pas en charge tous les formats de fichiers partagés. Les fichiers 
dont les formats ne sont pas pris en charge par AllShare ne s'afficheront pas à 
l'écran de l'ordinateur, même s'ils sont partagés sur l'ordinateur.

●● Vous ne pouvez visionner que les fichiers de vidéo, de photo et de musique.

Les sous-titres s'affichent correctement en cas de lecture de vidéo depuis 
un périphérique USB, mais pas lorsque la lecture s'effectue via AllShare et la 
connexion à l'ordinateur.

●● Vérifiez que le fichier de sous-titres et le fichier vidéo portent le même nom (par ex., 
Edge_City.mp4 and Edge City.srt) et qu'ils sont tous deux stockés dans le même 
dossier.

●● Notez que cette fonction n'est prise en charge que sur les produits Samsung 
compatibles avec AllShare. Cette fonction ne sera pas prise en charge si le téléphone 
intelligent que vous utilisez n'est pas un produit Samsung. 


